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1. UVOD 
 

Energetski transformatori su statički uređaji koji se sastoje od aktivnih i pasivnih dijelova. 

Aktivne dijelove čine jezgra i namoti, a pasivne dijelove provodna izolacija, kotao, konzervator, 

hladnjaci. Imaju ključnu ulogu u elektroenergetskim sustavima, te omogućavaju prijenos i 

distribuciju električne energije s visokog na niski napon ili obrnuto. Za prijenos električne energije 

s jednog namota na drugi koriste elektromagnetsku indukciju. Kako se elektroenergetski sustavi 

šire i postaju sve složeniji, zaštita energetskih transformatora je od iznimne važnosti. Oštećenje ili 

kvar transformatora rezultiraju narušavanju pouzdanosti elektroenergetskog sustava, osiguranje 

kontinuirane opskrbe električne energije, te financijske gubitke zbog svoje skupe izvedbe.  

Cilj ovog diplomskog rada je obraditi različite vrste zaštita transformatora. U prvom dijelu rada 

opisati će se princip rada transformatora, njegovi najvažniji dijelovi, te vrste i nadomjesni modeli 

transformatora.  

Nadalje u drugom dijelu rada opisati će se detaljnije uzroci nastanka kvarova u pojedinim 

dijelovima transformatora poput kvarova u namotima, jezgri i izolacijama koji proizlaze iz 

električnih, mehaničkih i toplinskih kvarova. Nakon toga će se obraditi sve vrste zaštita poput 

diferencijalne zaštite, zaštite od zemljospoja, bucholzove zaštite, zaštita od preopterećenja, 

nadstrujne zaštite i distantne zaštite.  

Na kraju ovog rada ćemo prikazati postupak izrade sheme u programskom paketu EPLAN-a i 

na toj shemi izvršiti proračun podešenja diferencijalne zaštite.   
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2. TRANSFORMATOR 
 

Električni transformatori su strojevi koji prenose električnu energiju iz jednog strujnog kruga 

u drugi uz promjenu razine napona, ali bez promjene frekvencije. Transformatori su dizajnirani za 

korištenje izmjenične struje, što znači da promjena napona napajanja utječe na promjenu električne 

struje. Dakle, povećanje električne struje će dovesti do smanjenja napona i obratno.  

Transformatori su jako skupi uređaji, te je neophodno ugraditi dobru izvedbu zaštite kako se 

njegova sigurnost i učinkovitost ne bi ugrozila. On služi za prijenos energije na velike udaljenosti. 

Na samom početku prilikom prijenosa te energije potrebno je postaviti transformator koji će velike 

struje i niske napone koje su proizvedene u određenom postrojenju pretvoriti u male struje i visoke 

napone, a na kraju kako dolazimo do potrošača moramo opet postaviti transformator koji će 

smanjiti napon odnosno transformirati ga na određeni napon.  

 

2.1. Princip rada transformatora 

 

Električni transformator radi na principu Faradeyevog zakona elektromagnetske indukcije. 

Prema načelu međusobnog induktiviteta, kada se na primarni namot transformatora dovede 

izmjenični napon, u jezgri se stvara magnetski tok ϕ. Ovaj magnetski tok povezuje oba namota i 

inducira elektromotornu silu E1 u primarnom namotu i E2 u sekundarnom namotu transformatora 

prema Faradeyevom zakonu elektromagnetske indukcije. [1] 

 

Elektromotorna sila primara računa se prema izrazu (2.1):  

 

𝐸1 =  − 𝑁1 
𝑑𝜙

𝑑𝑡
   (2.1) 

 

gdje je:  

     𝑁1    broj zavoja namota 

     
𝑑𝜙

𝑑𝑡
   promjena magnetskog toka po jedinici vremena. 
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Elektromotorna sila sekundara računa se prema izrazu (2.2):  

 

𝐸2 =  − 𝑁2 
𝑑𝜙

𝑑𝑡
    (2.2) 

 

gdje je:  

     𝑁2    broj zavoja namota 

     
𝑑𝜙

𝑑𝑡
   promjena magnetskog toka po jedinici vremena. 

 

Iz izraza (2.1) i (2.2) slijedi da su omjeri elektromotornih sila primara i sekundara jednaki 

omjerima zavoja primara i sekundara (2.3): 

 

  
𝐸1

𝐸2
=  

𝑁1

𝑁2
     (2.3) 

 

Iz izraza (2.3) može se vidjeti da veličina elektromotorne sile E1 i E2 ovisi o broju zavoja u 

primarnom i sekundarnom namotu, tj. ako je N2 > N1, onda je E2 > E1, tako da će transformator biti 

uzlazni transformator, a ako je N2 < N1, onda je E2 < E1, prema tome transformator će biti silazni 

transformator. 

U izrazu (2.4) prikazan nam je odnos omjera struja i broja zavoja primara i sekundara: 

 

         
𝐼1

𝐼2
=  

𝑁2

𝑁1
                 (2.4) 

 

Prema izrazu (2.5), napon i struja obrnuto su proporcionalni što znači da ako se poveća napon 

struja će se smanjiti:  

 

                
𝑈1

𝑈2
=  

𝐼2

𝐼1
       (2.5)     
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Slika 2.1. Shema transformatora 

 

2.2. Vrste transformatora 

 

Postoje različite vrste transformatora ovisno o njihovoj uporabi, dizajnu, konstrukciji itd. 

 

2.2.1. Podjela transformatora prema vrsti jezgre 

 

S obzirom na vrstu jezgre, transformatore dijelimo na: 

• Transformatori sa zračnom jezgrom 

• Transformatori sa feromagnetskom/željeznom jezgrom. 

 

Transformatori sa zračnom jezgrom koriste plastiku ili zrak kao jezgru. Namoti su ili omotani 

oko plastične jezgre ili fizičke jezgre nema. Zavojnice transformatora se nalaze u zraku i nisu 

povezane električki, ali ih povezuje zajednički magnetski tok koji protječe kroz zrak. Odsutnost 

feromagnetske jezgre smanjuje gubitke u jezgri, budući da ti gubici rastu s frekvencijom. 

Feromagnetski materijal također uzrokuje izobličenje visokofrekventnog signala. Tako je 

transformator sa zračnom jezgrom prikladan za radiofrekvencijsku struju. Još jedna pozitivna 

strana transformatora je ta što su lagani i prikladni za mobilne elektroničke uređaje poput radio 

odašiljača itd. 
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Transformatori sa feromagnetskom željeznom jezgrom kao što i naziv sugerira, ima jezgru 

izgrađenu od feromagnetskog materijala. Feromagnetska jezgra koristi se u transformatoru za 

povećanje njegovog magnetskog polja. Jakost magnetskog polja ovisi o magnetskoj propusnosti 

materijala koji se koristi. Željezo je uobičajeni feromagnetski materijal koji se koristi u takvim 

transformatorima. Transformatori sa željeznom jezgrom koriste se za primjenu s velikim 

opterećenjem niske frekvencije kao što su izvori napajanja. Željezna jezgra uključuje svoje gubitke 

u jezgri ovisne o frekvenciji kao što su gubitci vrtložne struje i histereze. Ovi transformatori se 

koriste se za povećanje ili smanjenje razine izmjeničnog napona. 

 

2.2.2. Podjela transformatora na temelju pretvorbe napona 

 

Transformatori se također klasificiraju na temelju pretvorbe razine izmjeničnog napona: 

• Uzlazni transformatori ( Step up transformatori ) 

• Silazni transformatori ( Step down transformatori ) 

 

Uzlazni transformatori su transformatori kod kojih je napon sekundarnog namota veći od 

napona primarnog namota. To je zato što je broj zavoja u primarnom namotu manji od broja zavoja 

u sekundarnom namotu. Izlazni napon transformatora ovisi o njegovom omjeru broja zavoja koji 

je dan izrazom (2.2.1): 

 

𝑜𝑚𝑗𝑒𝑟 𝑏𝑟𝑜𝑗𝑎 𝑧𝑎𝑣𝑜𝑗𝑎 =  
𝑁1

𝑁2
  (2.6) 

 

Kod uzlaznog transformatora omjer broja zavoja je veći od 1. Kao što znamo, ulazna i izlazna 

snaga transformatora ostaje ista. To znači da uzlazni transformator povećava napon, ali također 

smanjuje struju od primarnog do sekundarnog namota te tako održava konstantnu snagu. Uzlazni 

transformatori se uglavnom koriste u prijenosu energije na velike udaljenosti kako bi se smanjili 

gubici u liniji. Gubici u liniji ovise o struji, tako da se smanjenjem struje (uz povećanje napona) 

pomoću uzlaznog transformatora smanjuje gubitak i osigurava učinkovit prijenos energije. 

Mikrovalna pećnica također koristi uzlazni transformator za povećanje kućnog napona (110/220) 

na raspon od 2000 V. 
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Silazni transformatori smanjuju izmjenični napon, tj. izlazni napon je niži od ulaznog napona. 

Broj zavoja u primarnom namotu veći je od broja zavoja u sekundarnom namotu. Omjer broja 

zavoja silaznog transformatora manji je od 1. Najčešći silazni transformatori koriste se za 

smanjenje napona od 11 kV iz dalekovoda na standardni napon potrošača koji se koristi za 

kućanske uređaje. Svaki punjač za mobitele koristi silazni transformator. 

 

 

Slika 2.2. Prikaz silaznog i uzlaznog transformatora 

 

2.2.3. Podjela transformatora prema primjeni 

 

Prema primjeni, transformatori se dijele na: 

• Energetski transformatori 

• Distribucijski transformatori 

• Izolacijski transformatori 

• Mjerni transformatori 

 

Energetski transformatori koriste se u prijenosu energije pojačavanjem i snižavanjem napona 

u postrojenju za proizvodnju električne energije i za učinkovit prijenos. Linijski gubici ovise o 

struji. Kako bi smanjili linijsku struju, povećamo linijski napon uz pomoć transformatora snage. 

Njihov radni napon je vrlo visok u rasponu od preko 33 kV sa nazivnom snagom većom od 200 

MVA. Ogromne su veličine i rade pri maksimalnom opterećenju sa sto postotnom učinkovitosti.  

Distribucijski transformatori se koriste za distribuciju električne energije u kućanstvima ili u 

komercionalne svrhe. Oni spuštaju visoke mrežne napone ( >11 kV) u standardni kućni napon  
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(120/240 V). Manjih su dimenzija u usporedbi s energetskim transformatorima i lako se 

postavljaju. Imaju niski napon i nazivnu snagu, obično ispod 200 MVA. Njihova učinkovitost 

ostaje ispod 70% jer nikada ne rade pod punim opterećenjem.  

 

 

Slika 2.3. Distribucijski transformator 

 

Izolacijski transformatori se koriste za električno odvajanje uređaja od električne mreže u svrhu 

sprječavanja strujnog udara. Jedan kraj primara izolacijskog transformatora je uzemljen. U slučaju 

da netko dotakne goli vodič na sekundarnoj strani, neće biti struje. Krug je nepotpun jer će zemlja 

imati isti potencijal kao ta osoba. Transformatori omjera zavoja 1:1 uglavnom se koriste kao 

izolacijski transformatori, ali mogu biti dizajnirani kao uzlazni ili silazni transformatori. Izrađeni 

su od posebnog izolacijskog materijala između namota koji može podnijeti visoke izmjenične 

napone i zbog svoje kapacitivnosti u potpunosti blokira bilo koju istosmjernu komponentu. Između 

namota se nalazi uzemljeni Faradayev kavez koji potiskuje bilo kakvu buku ili smetnju. Koriste se 

za sigurnosna mjerenja kako bi se spriječili bilo kakvi strujni udari ili spajanje dva strujna kruga 

koja ne bi trebala biti električno povezana. 
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Slika 2.4. Izolacijski transformator 

 

Mjerni transformatori koriste se za mjerenje visokog napona i struje. Ovi transformatori 

smanjuju napon i struju do sigurnog raspona, koji se lako mjeri tipičnim mjernim instrumentima. 

Postoje dvije vrste mjernih transformatora: 

• Strujni mjerni transformatori 

• Naponski mjerni transformatori 

 

Strujni mjerni transformatori koriste se za mjerenje jako velike struje. Koriste se diljem svijeta 

za nadzor visokonaponskih vodova u električnim mrežama. Dizajnirani su da proizvode 

izmjeničnu struju u svom sekundarnom namotu koja je proporcionalna struji koju mjeri u svom 

primarnom namotu.  

Naponski mjerni transformatori se koriste za mjerenje visokih napona. Kako bi to bilo moguće, 

primarni namot transformatora spojen je preko vodova visokog napona. Na sekundarnoj strani su 

svi mjerni alati i instrumenti, kao što su mjerači povezani za mjerenje i analizu razine napona. 

Primarni namot je uzemljen ili smješten na tlu gdje naponski transformator povećava vrijednost 

napona na sigurnu razinu. 
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Slika 2.5. Naponski mjerni transfromatori 
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3. DIJELOVI ENERGETSKOG TRANSFORMATORA 
 

Dijelimo ih na aktivne i pasivne dijelove. Aktivni dijelovi transformatora su jezgra, namoti, 

stezni sustav i regulacijska sklopka, te oni osiguravaju transformaciju električne energije. Pasivni 

dijelovi transformatora su provodna izolacija, kotao, konzervator, hladnjaci i ventilatori.  

 

3.1. Jezgra 

 

Magnetska jezgra koja osigurava magnetsko polje (put) za usmjeravanje toka, sastoji se od 

tankih traka visoko kvalitetnog čelika, zvanih laminati. Trake se mogu slagati ili namotavati, pri 

čemu su namoti ugrađeni integralno oko jezgre ili su izrađeni odvojeno i sastavljeni oko sekcija 

jezgre. Jezgru čine stupovi na koje se namotavaju namoti, te jarmovi koji spajaju stupove u 

konstrukciju. Prije provođenja mehaničke obrade limovi se izoliraju samo s jedne strane kako se 

ne bi ostvario doticaj između limova. Za zaštitu limova mogu se koristiti izolacije poput laka, 

vodenog stakla ili svilenog papir, te imaju ulogu ograničiti vrtložne struje koje mogu uzrokovati 

oštećenje namota i jezgre. [1] 

Čelik za jezgru može biti toplo ili hladno valjan. Osnovna razlika između njih je da hladni u 

odnosu na toplo valjane limove imaju manje gubitke u željezu i manju struju magnetiziranja, te 

imaju veću korisnost i danas se najčešće koriste. 

Debljina transformatorskih limova kreće se od 0,23 mm do 0,36 mm. Poprečni presjek jezgre 

može biti kružni ili pravokutni. Pravokutne jezgre koriste čeličnu traku jedne širine, dok kružne 

jezgre koriste kombinaciju različitih širina trake za aproksimaciju kružnog presjeka.  

Postoje dvije osnovne konstrukcije jezgre koje se koriste u energetskim transformatorima: 

• Jezgrasti 

• Ogrnuti  

U jezgrastoj konstrukciji imamo namote oko jezgre u kojima se magnetski tok dijeli 

ravnomjerno na obje polovice jezgre, dok kod ogrnutog tipa namoti su ogrnuti jezgrom. Smanjenje 

magnetskog otpora na spojevima za jezgrasti tip je da se laminati režu u L, a za ogrnuti tip u obliku 

E. 
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Slika 3.1. Transformator s jezgrastim tipom 

 

3.2. Namoti 

 

Namoti se sastoje od vodiča kojima teče struja omotanih oko dijelova jezgre i oni moraju biti 

pravilno izolirani, poduprti i ohlađeni kako bi izdržali uvjete rada i ispitivanja. Uloga namota je 

pretvorba potencijala viših napona u niže, te obratno. Transformatori imaju dvije vrste namota: 

primarne i sekundarne. Namoti primara se napajaju iz generatora, te se preko njih prenosi 

električna energija dalje na sekundar koji predaje energiju trošilu koje je priključeno na mrežu. 

Bakar i aluminij su primarni materijali koji se koriste kao vodiči u namotima energetskih 

transformatora. Mehanička čvrstoća i vodljivost su visoke za bakar, dok su aluminijski materijali 

jeftiniji i laganiji u usporedbi s bakrom. Općenito, bakreni namoti se koriste u velikim 

transformatorima i za žice namotaja, dok se aluminijski vodiči koriste za male i srednje 

transformatore. Vrste namota prema izvedbi dijelimo na: cilindrične i plosnate. [1] 

Vrste namatanja transformatora mogu biti niskonaponski i visokonaponski namotaji. Razlika 

između njih je da kroz niskonaponske teče visoka struja koja uzrokuje zagrijavanje sustava, a 

smještena je uz jezgru, dok se visokonaponski slažu tj. namataju oko niskonaponskih namotaja.  
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Slika 3.2. Namoti transformatora 

 

Zahtjevi za namote transformaotra: 

• Namoti bi trebali biti ekonomični kako u smislu početne cijene, uzimajući u obzir 

dostupnost bakra na tržištu, tako i u smislu učinkovitosti transformatora 

• Namoti transformatora moraju zadovoljiti određene temperaturne zahtjeve, jer će 

odstupanje od ovih uvjeta drastično skratiti životni vijek transformatora 

• Namoti moraju biti mehanički stabilni u odnosu na sile koje proizlaze iz iznenadnih 

kratkih spojeva u transformatorima 

• Električna čvrstoća mora biti dovoljna da izdrži prenapone 

 

U mnogim slučajevima ovi zahtjevi su u suprotnosti jedan s drugim. Npr., veća gustoća struje 

u namotu znači da je potrebno manje bakra, ali se povećavaju gubici u bakru, što smanjuje 

učinkovitost transformatora. Dopuštanje većeg porasta temperature u namotu rezultira manjim 

transformatorom, ali s kraćim vijekom trajanja. Zbog toga je iznimno važno projektirati namot 

suvremenog transformatora, osobito kod visokonaponskih transformatora.  

 



13 

 

3.3. Kotao 

 

Kotao je kućište energetskog transformatora izrađen od željeznog lima, te spada u pasivne 

dijelove. U tom kućištu su smješteni:  

• Željezna jezgra 

• Namoti 

• Konzervator 

• Provodni izolator 

• Kotao za ulje. 

Koristi se za držanje, hlađenje i zaštitu namota i jezgre u transformatoru. Služi kao spremnik 

za ulje i potpora za sve ostale dodatke transformatora te štiti jezgru i namote od vanjskog 

okruženja. Toplina koju ulje uzima od namota ili željezne jezgre odlazi u okolinu putem radijatora, 

cijevi ili rebara koje se na kotao smještaju.  

 

 

Slika 3.3. Kotao transformatora 
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3.4. Provodni izolatori 

 

Provodnici na transformatoru omogućavaju prolaz vodiča kroz kotao čime se ostvaruje 

mogućnost povezivanja transformatora i energetskog postrojenja. Osim vođenja struje, zadaća 

provodnika je i izoliranje vodiča, odnosno visokog napona prema kotlu.  

Nakon procesa završne montaže između vodiča i izolatora nalazi se transformatorsko ulje koje 

su puni do vrha izolatora. Za više napone koriste se takozvani kondenzatorski provodnici koji 

imaju dodatnu papirnu izolaciju između vodiča i izolatora u koju se na određenim promjerima 

umetne aluminijska folija čime se dobiva niz serijski spojenih koncentrično smještenih 

kondenzatora. Na taj način ujednačavaju se dielektrična naprezanja unutar provodnika pa oni u 

odnosu na porculanske provodnike istog napona imaju znatno manje radijalne izmjene.  

Treća zadaća provodnika uz vođenje i izoliranje je odvajanje izolacijskih medija u 

transformatoru od drugog izolacijskog medija na koji se on spaja. Izolacijski medij energetskih 

transformatora je transformatorsko ulje, a drugi medij najčešće je zrak, ali može biti i plin 

sumporov heksafluorid SF6 ili opet transformatorsko ulje.  

U transformatorskoj tehnici se najčešće koriste sljedeće vrste provodnika: 

• Porculanski provodnici 

• Kondenzatorski provodnici 

• Ostali provodnici 

 

Porculanski provodnici prevladavaju na distribucijskim naponima, unutrašnji izolacijski medij 

je ulje i vanjski omotač je porculanski. 

Kondenzatorski provodnici već dugi niz godina u potpunosti prevladavaju na višim naponima 

iznad maksimalnog napona opreme 52 kV. Vanjski omotač može biti porculanski ili silikonski. 

U ostale provodnike ubrajaju se provodnici sa steznim priključkom koji se koriste na naponima 

do 1 kV, sabirnički provodni izolatori koji se također koriste na naponima do 1 kV, provodnici za 

brzo spajanje kabelskih priključaka koji se najčešće koriste s vanjskim priključkom i aralditnim 

izolatorom te kombinirani provodnici koji su alternativa za porculanske provodnike na naponima 

24 – 72,5 kV. Kod kombiniranih provodnika vodič je zaliven u organsku smolu, a vanjski omotač 

je od silikonske gume. 
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Slika 3.4. Provodni izolatori 

 

Većina energetskih transformatora ima celulozu (papir/prešani karton) i ulje kao izolacijske 

materijale. Izolacija je potrebna između jezgre i namota, kao i između svakog zavoja namota i 

kućišta za sve komponente koje provode električnu struju. Izolatori moraju izdržati visoke 

temperature, imati dobre mehaničke kvalitete i visoku dielektričnu čvrstoću.  

 

3.5. Transformatorsko ulje 

 

Sklop jezgre i namota izolirani su i hlađeni pomoću transformatorskog ulja. Jezgra i namoti 

transformatora moraju biti potpuno uronjeni u ulje, koje obično sadrži mineralna ulja s 

ugljikovodicima.  

Transformatorsko ulje osigurava dodatnu izolaciju između dijelova vodiča, poboljšava 

raspršivanje topline i otkriva greške, posebno u transformatorima uronjenim u ulje. 

Transformatorsko ulje ima plamište 310 °C, relativnu propusnot 2,7 °C i gustoću 0,96 kg/cm3. 

Četiri glavne funkcije transformatorskog ulja su: 

• Prijenos topline 

• Povećanje dielektrične čvrstoće 
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• Testiranje medija 

• Zaštita izolacije 

 

Funkcija prijenosa topline podrazumijeva raspršivanje topline iz jezgre i namota. Dok 

transformator radi, stvara se toplina kao posljedica opterećenja na transformatoru i okolne 

temperature, a funkcija ulja je da tu toplinu prenosi u okolinu kako bi se zaštitio transformator i 

produljio vijek trajanja transformatora.  

I ulje i papir unutar transformatora imaju dielektričnu čvrstoću. U kombinaciji, ulje i papir daju 

23% veću dielektričnu čvrstoću.  

Reprezentativni uzorak ulja može se izvući i poslati u laboratorij na testiranje. Rezultati 

testiranja medija mogu znatno produljiti vijek trajanja opreme. 

Zaštita izolacije je daleko najvažnija karakteristika transformatorskog ulja, ona podrazumijeva 

zaštitu čvrste izolacije (papir).  

 

3.6. Konzervator 

 

Konzervatorski spremnik transformatora jednostavno se definira kao cilindrični spremnik 

postavljen na krov glavnog spremnika transformatora. Služi za osiguravanje dovoljnog prostora 

za rastezanje ulja u transformatoru nakon zagrijavanja. Ima Buchholzov relej montiran na cijevi 

koja ga povezuje s glavnim spremnikom. Da bi se pokazalo koliko ulja ima u spremniku 

konzervatora, na konzervatoru ulja nalazi se indikator razine ulja. 

 

3.6.1. Buchholzov relej 

 

Buchholzov relej je sigurnosni uređaj montiran na energetske transformatore i reaktore punjene 

uljem, opremljen vanjskim spremnikom ulja iznad glave koji se naziva konzervator. Buchholzovi 

releji se koriste kao zaštitni uređaji, jer su osjetljivi na učinke dielektričnog kvara koji se može 

dogoditi unutar opreme koju štite. Buchholzovi releji su vrsta releja za detekciju plina. 

Princip rada Buchholzovog releja je vrlo jednostavan. Pokreće se mehanički. Kad god dođe do 

manjeg unutarnjeg kvara u transformatoru, kao što je kvar izolacije između zavoja, kvar jezgre 
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transformatora, zagrijavanje jezgre, izolacijsko transformatorsko ulje će se razgraditi u različitim 

plinovima ugljikovodika, CO i CO2. Plinovi koji nastaju zbog isparavanja izolacijskog ulja 

transformatora nakupljati će se u gornjem dijelu Buchholzovog spremnika što uzrokuje pad razine 

ulja u njemu. Kada dođe do toga, prekidač povezan s transformatorom odmah izolirala neispravni 

transformator od ostatke elektroenergetskog sustava međusobnim okidanjem prekidača povezanih 

s NN i VN stranama transformatora. 

 

 

Slika 3.5. Buchholzov relej 
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4. NADOMJESNI MODELI ENERGETSKIH TRANSFORMATORA 
 

4.1. Dvonamotni transformatori 

 

Na slici 4.1. prikazana je ekvivalenta shema dvonamotnog transformatora. 

 

 

Slika 4.1. Ekvivalenta  jednofazna shema dvonamotnog transformatora 

 

Na slici 4.2. prikazana je trofazna shema dvonamotnog transformatora. 

 

 

Slika 4.2. Trofazna shema dvonamotnog transformatora 
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gdje su: 

• Z1 – impedancija primarne strane 

• Z2 – impedancija sekundarne strane 

• R1 i R2 – djelatni (radni) otpor 

• X1σ i X2σ – rasipna reaktancija  

• Z0 – impedancija poprečne grana 

• Xµ - reaktivni gubici uslijed struje magnetiziranja 

• R0 – radni gubici u željezu  

• IT – idealni transformator 

 

Na slici 4.3. prikazana je trofazna shema dvonamotnog transformatora preračunata na 

sekundarnu stranu. 

 

 

Slika 4.3. Trofazna shema dvonamotnog transformatora preračunata na sekundarnu stranu 

 

Izrazom (4.1) preračunavamo primarne veličine na sekundarnu stranu: 

 

𝑆 =  
𝑈1

2

𝑍1
=  

𝑈2
2

𝑍′′1
  (4.1.) 
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Preračunate impedancije (primarna i popriječena) računaju se pomoću slijedećih izraza (4.2) i 

(4.3): 

 

𝑍1′′ =  𝑍1 (
𝑈2

𝑈1
)

2

  (4.2) 

 

𝑍0′′ =  𝑍0 (
𝑈2

𝑈1
)

2

  (4.3) 

 

Na slici 4.4. prikazana je trofazna shema dvonamotnog transformatora preračunata na primarnu 

stranu. 

 

 

Slika 4.4. Trofazna shema dvonamotnog transformatora preračunata na primarnu stranu 

 

Izrazom (4.4) preračunavamo sekundarne veličine na primarnu stranu: 

 

𝑆 =  
𝑈1

2

𝑍2
=  

𝑈2
2

𝑍′2
  (4.4) 

 

Preračunata sekundarna impedancija računa se prema izrazu (4.5): 

 

𝑍2′ =  𝑍2 (
𝑈1

𝑈2
)

2

   (4.5) 
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gdje su: 

• S – snaga transformatora 

• U1 – napon primara 

• U2 – napon sekundara 

 

4.2.  Nadomjesni T model transformatora 

 

Na slici 4.5 prikazan je nadomjesni T model transformatora. Takva vrsta spoja transformatora 

nam pruža najveću točnost u odnosu na ostale spojeve. 

 

 

Slika 4.5. Nadomjesni T model transformatora 

 

Preračunavanje poprečne impedancije Z0 u admitanciju vrši se prema slijedećim izrazima: 

 

𝑍0 =  
𝑅0∗𝑗𝑋0

𝑅0+𝑗𝑋0
             (4.6) 

 

𝑌0 =
1

𝑍0
=  

𝑅0∗𝑗𝑋0

𝑅0+𝑗𝑋0
=

1

𝑅0
− 𝑗

1

𝑋0
 (4.7) 

 

           𝐺0 =
1

𝑅0
              (4.8) 
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           𝐵0 = −
1

𝑋0
    (4.9) 

 

              𝑌0 = 𝐺0 − 𝑗𝐵0     (4.10) 

 

gdje su: 

• 𝑍0 – poprečna impedancija 

• 𝑌0 - admitancija 

• 𝐺0 – električna vodljivost 

• 𝐵0 – reaktivna vodljivost ili susceptancija 

 

4.3. Nadomjesni Γ i I modeli transformatora  

 

Na slici 4.6. prikazani su Γ i I nadomjesni modeli transformatora. Ovi nadomjesni modeli se 

koriste u slučajevima kada nam nije potrebna tolika točnost u proračunu već što brže dobiti 

približno točna rješenja. Razlika između njih je da se u I nadomjesnom modelu zanemaruje 

poprečna grana, te pomoću njega možemo izračunavati prilike kratkog spoja. 

 

  

Slika 4.6. a) nadomjesni Γ model i b) nadomjesni I model transformatora 
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Parametre koje možemo izračunati preko Γ nadomjesnog modela su: 

• Un1 – napon primarnog namota 

• Un2 – napon sekundarnog namota 

• Sn – nazivna snaga 

• Pk – gubici kratkog spoja  

• io% – struja magnetiziranja 

• P0 – gubici praznog hoda 

• ukT% - napon kratkog spoja 

 

Parametre uzdužne grane računamo prema izrazima (4.11) i (4.12): 

 

           𝑅𝑘 =  
𝑃𝑘∗𝑈𝑛

2

𝑆𝑛
2   (4.11) 

 

𝑋𝑘 =  
𝑢𝑘𝑇%

100
∗

𝑈𝑛
2

𝑆𝑛
  (4.12) 

 

Parametre poprečne grane računamo prema izrazima (4.13) i (4.14): 

 

             𝐺0 =
𝑃0

𝑈𝑛
2                (4.13) 

 

        𝐵0 =
𝑖0%

100
∗

𝑆𝑛

𝑈𝑛
2      (4.14) 
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4.4. Nadomjesni π model transformatora 

 

Na slici 4.7. prikazan je nadomjesni π model transformatora. U odnosu na T model sada imamo 

dvije poprečne grane, te jednu Z impedanciju u uzdužnoj grani. Ova vrsta spoja nije točnija od T 

izvedbe i najčešće se koristi u izvedbama mreže s regulacijskim transformatorom. 

 

 

Slika 4.7. Nadomjesni π model transformatora 

 

4.5. Tronamotni transformatori 

 

Izvedba tronamotnih transformatora sastoji se od 3 priključka, te služi za kao veza prema 

prijenosnoj mreži. Svaki od namota (primar, sekundar i tercijar) imaju određenu ulogu. Za razliku 

od dvonamotnih dodavanjem tercijarnog namota u tronamotnom transformatoru dobivamo namot 

koji najčešće napaja distribucijsku mrežu. Transformacija napona vrši se između primara i 

sekundara, te primara i tercijara.  

Na slici 4.8. prikazana je trofazna shema tronamotnog transformatora.  
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Slika 4.8. Trofazna shema tronamotnog transformatora 

 

Na slici 4.9. prikazana je trofazna shema dvonamotnog transformatora preračunata na primarnu 

stranu.  

 

 

Slika 4.9. Trofazna shema tronamotnog transformatora preračunata na primarnu stranu 
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Na slici 4.10. prikazana je trofazna shema tronamotnog transformatora preračunata na 

sekundarnu stranu.  

 

 

Slika 4.10. Trofazna shema tronamotnog transformatora preračunata na sekundarnu stranu 

 

Na slici 4.11. prikazana je trofazna shema tronamotnog transformatora preračunata na 

tercijarnu stranu.  

 

 

Slika 4.11. Trofazna shema tronamotnog transformatora preračunata na tercijarnu stranu 
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Slijedećim izrazima vršimo preračunavanja između pojedinih namota: 

 

          𝑍1′′ =  𝑍1 (
𝑈2

𝑈1
)

2

      (4.15) 

 

          𝑍1′′ =  𝑍1 (
𝑈3

𝑈1
)

2

                     (4.16) 

 

           𝑍2′ =  𝑍2 (
𝑈1

𝑈2
)

2

                 (4.17) 

 

          𝑍2′′′ =  𝑍2 (
𝑈3

𝑈2
)

2

                 (4.18) 

 

            𝑍3′ =  𝑍3 (
𝑈1

𝑈3
)

2

       (4.19) 

 

            𝑍3′′ =  𝑍3 (
𝑈2

𝑈3
)

2

                  (4.20) 

 

4.6. Struja magnetiziranja 

 

Određenu količinu struje transformator povlači iz izvora spojenog na njegov primarni dio čak 

i kada na njegov sekundar nije spojeno nikakvo opterećenje, te kroz njegov primar teče struja 

praznoga hoda I0. Dio struje praznoga hoda koristi se za uspostavljanje toka u jezgri transformatora 

i tu struju nazivamo struja magnetiziranja Iµ. Struju praznoga hoda čine struja magnetiziranja Iµ i 

struja gubitaka u željeznoj jezgri i namotima primara IR. Ako zanemarimo malu struju IR u odnosu 

na struju praznoga hoda dobivamo da je struja praznoga hoda jednaka struji magnetiziranja. Pojava 

struje magnetiziranja se javlja prilikom ukapčanja transformatora na mrežu te je u većini slučajeva 

kratkotrajna, ali može doseći vrijednost struje 10 puta veću od nazivne.  
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Slika 4.12. Prikaz struje magnetiziranja 

 

Struja magnetiziranja nije sinusna već izobličena, te sadrži radnu i jalovu komponentu. Radna 

komponenta struje magnetiziranja je sinusna i u fazi je s narunitim naponom, dok jalova 

komponenta nije sinusna te mu osnovni harmonik zaostaje za naponom mreže za 90º plus viši 

harmonici.  

Struja magnetiziranja transformatorskog lima izrazito raste pri većim indukcijama u limu, pa 

se obično transformator projektira da indukcija ne prelazi iznos od 1,8 T pri nazivnom naponu. 

Razlog eventualnog izbora nižih vrijednosti indukcije može biti zahtjev za smanjenom bukom 

transformatora, no time se povećavaju dimenzije transformatora.  

 

 

Slika 4.13. Prikaz krivulje magnetiziranja 
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5. KVAROVI TRANSFORMATORA 

 

Energetski transformatori su središnji dio trafostanica i imaju vrlo važnu ulogu u 

elektroenergetskom sustavu. Iako su jedna od najpouzdanijih komponenti električne mreže, 

također su skloni kvarovima zbog unutarnjih i vanjskih čimbenika.  

Stanje i procjena rizika transformatora postaju sve važniji za poboljšanje performansi 

transformatora, produljenje njihovog životnog vijeka, smanjenje troškova i donošenje najboljih 

tehničkih i ekonomskih odluka, koje se tiču upravljanja njihovim životnim ciklusom. 

Najčešći kvar u transformatorima je degradacija izolacije zbog uvjeta preopterećenja sklopnih 

prenapona, munja itd. Zagrijavanje transformatora može povećati temperaturu izolacijskog 

sustava i na kraju može smanjiti učinkovitost izolacije. [2] 

 

5.1.  Vrste kvarova 

 

Načini kvarova mogu se podijeliti u sljedeće kategorije: 

• Električni kvarovi 

• Mehanički kvarovi 

• Toplinski kvarovi.  

 

Električni kvarovi dovode do oštećenja izolacijskog sustava transformatora. Proboj izolacije 

od zavoja do zavoja čest je uzrok električnog kvara u transformatorima. Degradacija izolacije 

događa se zbog iznenadnog visokog napona ili struje. Ovo oštećenje izolacije dovodi do preskoka 

zavoja namota i uzrokuje kratke spojeve. Električni kvarovi mogu se kategorizirati u sljedeće tri 

glavne vrste: 

• Prijelazna ili prenaponska stanja 

• Munje i sklopni udari 

• Djelomično pražnjenje. 

 

Ovi se kvarovi mogu pojaviti neovisno ili u kombinaciji stoga je važno procijeniti sve 

čimbenike za razvoj točnog scenarija kvara kako bi se analizirao kvar koji se dogodio u 
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transformatoru. Izolaciju transformatora treba provjeriti jer unutarnji električni kvar može 

rezultirati katastrofalnim kvarom i utjecati na rad. 

Mehanički kvarovi poput izobličenja ili bilo kakvih labavih namota rezultiraju oštećenjem 

namota transformatora, tj . pucanjem njegove čvrste izolacije. Ako je oštećenje akutno, 

transformator može električki otkazati. Glavni mehanički čimbenici odgovorni za kvarove 

transformatora su: 

• Elektromagnetske sile 

• Prevrtanje vodiča 

• Korozija 

• Izvijanje vodiča 

• Vibracije i mehanički pokreti u transformatoru 

• Kvar sustava za stezanje zavojnice 

• Pomak namota. 

 

Kod toplinskih kvarova, preopterećenje transformatora će dovesti do degradacije celulozne 

izolacije, koja se pogoršava zbog topline, oksidacije, kiselosti i vlage. To rezultira gubitkom 

dielektrične čvrstoće izolacije u namotu transformatora. Preostali čimbenici odgovorni za 

povećanje toplinskog naprezanja i gubitka izolacije u transformatoru su: 

• Kontinuirano preopterećenje transformatora 

• Nenormalni uvjeti opterećenja 

• Začepljenje uljnih kanala 

• Kvar rashladnog sustava 

• Okolišni uvjeti 

• Pretjerana pobuda transformatora. 

 

Toplinski kvar se može pojaviti u različitim dijelovima transformatora zbog gore navedenih 

čimbenika. Najvažniji parametar za povećanje životnog vijeka transformatora odnosi se na 

temperaturu najtoplijeg mjesta u namotu (hot-spot). Izravno mjerenje temperature najtoplijeg 

mjesta u namotu osigurati će točnu ispravnost jedinice. Praćenje temperature temeljeno na 

optičkim vlaknima smatra se najboljom metodom u usporedbi s drugim tradicionalnim sustavima 

praćenja. [2] 
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5.2. Kvarovi u namotu  

 

Dielektrične greške nastaju u namotu zbog proboja izolacije od zavoja do zavoja. Često dolazi 

do kvara izolacije zbog visoke struje i napona koji su iznad nazivne vrijednosti. Oštećenje izolacije 

rezultira preskokom zavoja namota i pojavom kratkog spoja.  

Namoti su obično od bakra. Zbog bakrenog voda dolazi do otpornih toplinskih gubitaka. Ovi 

toplinski gubitci uzrokuju pojavu najtoplijeg mjesta u namotu (hot-spot) zbog lošeg ili nikakvog 

održavanja. To s vremenom uzrokuje trošenje i smanjenje fizičkih snaga do točke pucanja namota.  

Mehaničke greške u namotu su iskrivljenje, olabavljenje ili pomak namota što rezultira 

smanjenjem performanse transformatora. Glavni razlozi koji uzorkuju ovu grešku su nepravilan 

popravak, loše održavanje, korozija, vibracije i mehanička kretanja unutar transformatora. [2] 

 

 

Slika 5.1. Prikaz deformacije namota 

 

5.3. Kvarovi čahure 

 

Čahure su izolacijski uređaji koji izoliraju visoko naponski električni vodič za prolazak kroz 

uzemljeni vodič. U transformatoru osigurava put struje kroz stijenku spremnika. Unutar 
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transformatora koriste se papirnati izolatori koji su okruženi uljem koje pruža dodatnu izolaciju. 

Neki od glavnih razloga kvara čahure opisani su u nastavku. 

Otpuštanje vodiča je uzrokovano transformatorskim vibracijama koje rezultiraju 

pregrijavanjem. Ovo pregrijavanje oštećuje izolacijski papir i ulje. 

Iznenadni visoki naponi kvara uzrokuju djelomično pražnjenje (proboj čvrstih/tekućih 

izolatora) koje oštećuje čahure i uzrokuje njihove degeneracije i potpuni kvar u roku od nekoliko 

sati. 

Lomljenje brtve čahure događa se zbog prodora vode, starenja ili prevelikih dielektričnih 

gubitaka. Zbog ove pojave dolazi do kvara transformatora. [2] 

 

 

Slika 5.2. Prikaz oštećene papirne izolacije kod kvara čahure 

 

5.4. Kvar jezgre 

 

Greške u jezgri izravno utječu na namote transformatora, uzrokujući kvarove u njima. Jezgre 

transformatora su laminirane za smanjenje vrtložnih struja. Laminacija jezgre može biti oštećena 
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lošim održavanjem, starim uljem ili korozijom. Kvar i najmanjeg dijela lamniacije rezultira 

povećanjem topline uslijed vrtložnih struja. Posljedice povećanja topline su: 

 

• Pregrijavanje doseže površinu jezgre koja je u izravnom kontaktu s namotima, rezultat 

je oštećenje namota zbog topline  

• Oštećenje ulja u transformatorima što rezultira oslobađanjem plina iz ulja koji oštećuje 

druge dijelove transformatora. [2] 

 

 

Slika 5.3. Prikaz kvara jezgre transformatora 

 

5.5. Kvar spremnika 

 

Funkcija spremnika u transformatoru je da bude spremnik za ulje koje služi za izolaciju i 

hlađenje. Kvar u spremniku može nastati zbog utjecaja okoline kao što su korozivna atmosfera, 

visoke vlažnosti i sunčevog zračenja što dovodi do curenja ili pukotina na stijenkama spremnika. 
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5.6. Kvar izolacije  

 

Izolacija se mehanički oštećuje zbog kretanja transformatora ili sile nastale tijekom kratkog 

spoja. Greške u izolacijskom materijalu mogu nastati zbog stvaranja bakrovog (2) sulfat 

pentahidrata poznatijeg kao modra galica ili zbog vrućih točaka stvorenih zbog male količine ulja 

ili preopterećenja transformatora.  [2] 

 

5.7. Kvar rashladnog ulja 

 

Transformatorsko ulje osigurava izolaciju između namota transformatora uz željeno hlađenje 

u transformatoru. Kvar rashladnog ulja uzrokuju dva razloga: neispravnost cirkulacije ulja ili loš 

prijenos topline na sekundarni krug hlađenja. Vlaga i kisik zajedno s toplinom predstavljaju glavni 

uzrok onečišćenja uljem. Samim time temperatura unutar transformatora će porasti i kvar uljne 

izolacije rezultirati kratkim spojem. [2] 
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6. ZAŠTITA TRANSFORMATORA 

 

Transformatori su jedan od najskupljih elemenata svakog distribucijskog sustava. Kao važan 

element elektroenergetskog sustava štiti se od unutarnjih i vanjskih kvarova, te pojava smetnji. 

Uslijed pojave kvara dolazi do poremećaja u radu energetskog transformatora, te dolazi do 

značajnih odstupanja od normalnih električnih prilika u vidu pojave proboja ili preskoka izolacije. 

Kako bi zaštitili transformator od pojave kvarova i ispada pogona iz mreže potrebno je postaviti 

kvalitetnu i odgovarajuću zaštitu za sustav.  

Zaštita transformatora može se općenito kategorizirati kao električna zaštita koja se provodi 

očitavanjem struje kroz njega, ali također i napona i frekvencije. Također možemo izvršiti i 

mehaničku zaštitu koja se provodi očitavanjem parametara kao što su tlak, razina ulja, nastali plin, 

temperatura ulja i namota.  

Metode zaštite transformatora uvelike se razlikuju, ovisno o primjeni i važnosti transformatora. 

Vrsta zaštite transformatora koja se koristi trebala bi minimalizirati vrijeme odstupanja zbog 

kvarova unutar transformatora i smanjiti rizik od većeg kvara kako bi se pojednostavio eventualni 

popravak. Da bi osigurali što manju štetu potrebno je da zaštitni releji što brže odvoje 

transformator od svih izvora napajanja kako bi se izbjeglo preskakanje kotla, te curenje i paljenje 

ulja. Duži rad transformatora u nenormalnim uvjetima kao što su kvarovi ili preopterećenja 

ugrožava životni vijek trajanja transformatora, što znači da treba osigurati odgovarajuću zaštitu za 

bržu izolaciju transformatora u takvim uvjetima.  

Za zaštitu energetskih transformatora koriste se slijedeće zaštite: 

• Diferencijalna zaštita 

• Zemljospojna zaštita 

• Bucholtzova (plinska) zaštita 

• Zaštita od preopterećenja 

• Nadstrujna zaštita 

• Homopolarna zaštita 

• Distantna zaštita  
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6.1. Diferencijalna zaštita 

 

Osnovni koncept svake diferencijalne zaštite je da je zbroj svih struja, koje ulaze u zaštitne 

zone, mora biti jednak zbroju struja, koje izlaze iz zaštitne zone. Ako to nije slučaj, došlo je do 

greške, te je možemo usporediti izravno sa prvim Kirchhoffovim zakonom. Predstavlja osnovnu 

zaštitu, te štiti transformator od pojave unutarnjih kvarova i najčešća je zaštita koja se koristi kod 

energetskih transformatora.  

Izvedbe diferencijalne zaštite mogu biti: 

• Elektromehaničke 

• Statičke 

• Numeričke 

 

Diferencijalna zaštita pokazala se kao efikasna zaštita od međufaznih kratkih spojeva, spojeva 

među zavojima i od proboja prema uzemljenim dijelovima ako je zvjezdište mreže kuto uzemljeno. 

Ugrađuje se za kod transformatora koji imaju snagu iznad 3 MVA, a obavezna je za snage iznad 

8 MVA.  

Svrha diferencijalne zaštita je otkrivanje i pouzdano rješavanje grešaka i kratkih spojeva s 

visokom selektivnošću i osjetljivošću. To znači da se može isključiti bez namjerne vremenske 

odgode za kvarove unutar njegove zone zaštite. Zaštita za proračun diferencijalne struje koristi 

struje koje mjere strujni transformatori na priključcima transformatora. Zone štićenja 

transformatora od kvara su između dva strujna transformatora. Promatramo li idealnu izvedbu 

energetskog transformatora, te uzmemo da su strujni transformatori na njegovim krajevima 

idealni, te kada nema kvara u štićenoj zoni, struja koja ulazi u štićenu zonu jednaka je struji koja 

izlazi iz štićene zone odnosno diferencijalna struja je jednaka nuli. Kako bi postignuli da nam 

diferencijalna struja bude jednaka nuli, neophodno je da nam struje na sekundarnima 

transformatora budu usuglašene. U slučaju kada je diferencijalna struja veća od nule znamo da 

dolazi do pojave kvara unutar zone koju štitimo. U normalnim uvjetima rada transformatora  

diferencijalna struja je veća od nule jer to dopušta diferencijalna zaštita iz razloga što struja 

magnetiziranja u praksi uzrokuje razliku između struje primara i sekundara. [3] 
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Diferencijalna zaštita može biti s dvije izvedbe releja, a to su: 

• Stabilizirani diferencijalni relej 

• Stabilizirani diferencijalni relej sa mogućnošću blokade prisustva viših harmonika 

 

 

Slika 6.1. Prikaz diferencijalnih releja za zaštitu transformatora 

 

Princip rada stabilizirane diferencijalne zaštite odnosno releja temelji se na usporedbi 

diferencijalne struje sa stabiliziranom. Na slici 6.2. imamo shemu diferencijalnog releja koji se 

sastoji od dva struja transformatora između kojeg se nalazi štićeni objekt tj. transformator u kojem 

djeluje diferencijalna zaštita. Štićeni objekt je spojen na sekundarne priključke strujnih 

transformatora, a relej se sastoji od stabilizacijske i diferencijalne grane. Stabilizacijska grana služi 

za stabilizaciju releja, a to ostvaruje adekvatno dimenzioniranim namotima preko kojih 

onemogućava iznenadne oscilacije kroz proradni namot. 
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6.2. Prikaz sheme diferencijalne zaštite 

 

Na slici 6.3. prikazano je reagiranje diferencijalne zaštite.  Uobičajeno vrijeme djelovanja je 

između 25-40 ms. Kako bi se zaštitili od kratkih spojeva u transformatoru i spojeva između zavoja 

iste faze potrebno je da se osjetljivost podesi između 20-40% nazivne struje. U slučaju djelovanja 

diferencijalne zaštite ponovno uključivanje se vrši tek kada se utvrdimo razlog djelovanja releja. 

 

 

Slika 6.3. Prikaz reagiranja diferencijalne zaštite  
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Značenje oznaka iz slike 6.3. su: 

• 1 – pogreška uzrokovana strujom magnetiziranja 

• 2 – pogreška zbog loše izvedbe strujnih transformatora 

• 3 – pogreška uzrokovana različitim prijenosnim omjerima transformatora 

• is – stabilizacijska struja 

• id – diferencijalna struja 

• inr – nazivna struja releja 

• g – osnovno podešenje 

• 𝑣 – koeficijent stabilizacije 

Djelovanje diferencijalne zaštite se javlja kada se nalazimo u području prorade, te znamo da je 

došlo do unutarnjeg kvara transformatora. Kada se nalazimo u području stabilizacije diferencijalna 

zaštita ne bih trebala reagirati i transformator radi u normalnom pogonu.   

Karakteristika djelovanja releja određena je slijedećim izrazima (6.1. i 6.2.) : 

 

            g =
𝑖𝑑

𝑖𝑛𝑟
∗ 100%, 𝑝𝑟𝑖 𝑖𝑠 = 0   (6.1) 

 

𝑣 =
𝑓(

𝑖𝑠
𝑖𝑛𝑟

=𝑎)−𝑓(
𝑖𝑠

𝑖𝑛𝑟
=1)

𝑎−1
∗ 100%, 𝑝𝑟𝑖 𝑎 > 1  (6.2) 

 

Obično se osnovno podešenje (g) i koeficijent stabilizacije (𝑣) podešavaju u području 20-50%. 

 

6.2. Zemljospojna zaštita 

 

Zemljospojna zaštita je zaštita od proboja izolacije dijelova transformatora prema uzemljenim 

dijelovima. Svrstavamo ju pod vrstu diferencijalne zaštite. Zaštita od zemljospoja ima jako 

osjetljivu detekciju na kvar. Funkcija zaštite od zemljospoja je minimiziranje štete na električnoj 

opremi kada se niska razina fazne struje vraća u opskrbni transformatora kroz povratni put 

uzemljenja.  
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Korištenje zemljospojne zaštite je jako bitno kod detekcije unutarnjih jednopolnih kratkih 

spojeva. Najbolji primjer toga je kada je zvjezdište transformatora uzemljeno preko otpora 

diferencijalna zaštita neće detektirati jednopolni kratki spoj, te će štiti  mali dio namota od proboja, 

dok zemljospojna zaštita štiti cijeli namot. Obično se to javlja kod transformatora velikih snaga. 

Razlog tome su velike proradne struje i male struje jednopolnog kratkog spoja.  

Za prepoznavanje kvara uzemljenja u kabelima koristi se megger (mjerač otpora izolacije). 

Jedan terminal meggera spojen je na vodič pod naponom, a drugi terminal spojen na uzemljenje. 

Ako megger pokazuje nulto očitanje, to znači da je vodič uzemljen.  

 

 

Slika 6.4. Prikaz sheme zemljospojne zaštite 

 

Pojava jednopolanog kvara K1 izvan transformatora uzrokuje da je zbroj svih struja faze 

identičan struji koja prolazi kroz strujni transformator (ST1). Pojava jednopolanog kvara K2 u 

transformatoru uzrokuje da je zbroj svih struja faze različit struji koja prolazi kroz strujni 

transformator (ST1). Razlika između jednopolnih kvarova K1 i K2 je da kod K1 imamo malu 

diferencijalnu struju, dok kod K2 je ta struja velika. Analogno tome kod jednopolanog kratkog 

spoja K4 zbroj struja kroz priključnice je identičan struji koja prolazi kroz strujni transformator 

(ST2). Dok kod pojave jednopolnog kvara K3 zbroj struja kroz priključnice je različit struji koja 

prolazi strujni transformator (ST2). 
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6.3. Zaštita od preopterećenja 

 

U slučaju kada dođe do ispada transformatora ili nagle pojave potrošnje u mreži, dolazi do 

preopterećenja ostatka transformatora koji se nalazi u mreži. Obično takva preopterećenja imaju 

dva ili više puta veću nazivnu struju i javljaju se kod transformatora koji povezuju prijenosne 

mreže s velikim potrošačima. Vrijeme provedeno pod preopterećenjem ovisit će o brzini reagiranja 

dispečerske službe i mogućnosti ponovnog uključenja ispalih ili rezervnih jedinica. 

Preopterećenje transformatora je ograničeno maksimalnom dozvoljenom temperaturom 

namota transformatora. Ta temperatura zavisi o vrsti izolaciji i vremenskom vijeku trajanja 

izolacije.  

Gubici u jezgri transformatora posljedica su vrtložne struje i histereze. Oni nisu ovisni o 

opterećenju transformatora. Gubici u namotima su pak ovisni o opterećenju transformatora. Oni 

rastu s porastom opterećenja transformatora i stoga može nastupiti nedozvoljeno toplinsko 

naprezanje transformatora. Povećanje unutarnje temperature transformatora ima negativne 

posljedice na njegovu životnu dob. Naime, povećanjem radne temperature transformatora 

smanjuje se životna dob njegove izolacije. Kako bi se to izbjeglo, koristi se termička zaštita 

energetskog transformatora. Njena osnovna zadaća je zaštiti transformator od strujnog 

preopterećenja.  

Termička zaštita nosi IEC oznaku ϑ> , odnosno, ANSI oznaku 49. Ona je često realizirana uz 

pomoć radne karakteristike štićenog objekta (energetskog transformatora). [4] 
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Slika 6.5. Prikaz djelovanja termičke zaštite 

 

6.4. Nadstrujna zaštita 

 

Uz diferencijalnu zaštitu energetskog transformatora, koristi se i nadstrujna zaštita koja 

predstavlja pričuvnu zaštitu transformatora. To znači da ako diferencijalna zaštita ne djeluje iz 

nekog razloga, tada bi energetski transformator trebala isključiti nadstrujna zaštita. 

Nadstrujna zaštita je neophodna za zaštitu namota transformatora i neovisna je o nadstrujnoj 

zaštiti potrebnoj za vodiče. 

Nadstrujni zaštititi uređaj štiti strujni krug otvaranjem uređaja kada struja dosegne vrijednost 

koja će uzrokovati pretjerano ili opasno povećanje temperature u vodičima. Većina nadstrujnih 

zaštitnih uređaja reagira i na vrijednosti struje kratkog spoja ili zemljospoja, kao i na uvjete 

preopterećenja. 
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Najčešće nadstrujne zaštite su: 

• Niskopodesiva nadstrujna zaštita 

• Visokopodesiva nadstrujna zaštita. 

 

Korištenje niskopodesive nadstrujne zaštite upotrebljava se u slučaju kada je struja 

jednopolnog kratkog spoja veća od maksimalne pogonske struje. Loša strana niskopodesive 

nadstrujne zaštite je pojava velike struje kratkog spoja. Za sigurno djelovanje ove zaštite mora biti 

zadovoljen slijedeći izraz: 

 

      𝐼𝑝𝑟 ≤
𝐼𝑘𝑚𝑖𝑛

𝑘𝑜𝑠∗𝑝𝑖
              (6.3) 

 

gdje je:  

• 𝐼𝑘𝑚𝑖𝑛 – minimalna struja kratkog spoja 

• 𝑘𝑜𝑠 – koeficijent osjetljivosti za osnovnu zonu štićenja se uzima 1,5 za rezervnu 1,2 

 

Kod međufaznih kvarova koristi se visokopodesiva nadstrujna zaštita. Njeno djelovanje 

pokriva samo dio u kojem se nalazi transformator stoga ju koristimo kod zaštite kvara unutar  

transformatora. Djelovanje visokopodesive nadstrujne zaštite počinje nakon 100 ms jer unutar 100 

ms djeluje diferencijalna zaštita. 

 

 

Slika 6.6. Prikaz nadstrujne zaštite dvonamotnog energetskog transformatora 
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Glavni nedostatak nadstrujne zaštite kod jako velikih transformatora je sporo vremensko 

djelovanje i uklanjanje kratkog spoja iz razloga kako bi se ostvarila selektivnost s dalekovodnim 

zaštitama. [4] 

 

6.5. Homopolarna zaštita 

 

Homopolarna zaštita služi za zaštitu od pojave kratkih spojeva između faza. Spada u jednu od 

vrsta nadstrujne zaštite i možemo ju podijelit na:  

• Niskopodesiva homopolarna zaštita 

• Viskopodesiva homopolarana zaštita 

 

Njeno djelovanje je također kao pričuvna zaštita za diferencijalnu zaštitu. U slučaju kada 

imamo transformator kojem je zvjezdište uzemljeno preko otpora nadstrujna zaštita nije dovoljno 

osjetljiva da bih ograničila jednopolnu struju kratkog spoja. Da bi se postigla veća osjetljivost 

potrebno je pokraj nadstrujne zaštite dodati i osjetljivu zaštitu nulte komponente struje podešene 

na 20% nazivne struje.  

Osim zaštite od pojave kratkih spojeva između faza ova zaštita ima zadatak da spriječi kvar ili 

izgaranje otpornika kada dođe do toga da dalekovodna ili nadstrujna homopolarna zaštita na 

sekundaru ne djeluju. 

 

Podešenje homopolarne zaštite provodi se slijedećim izrazom: 

 

𝐼𝑝𝑟0 = 𝑘𝑠 ∗ (
0,06

0,1
) ∗ 𝐼2𝑛   (6.4) 

 

gdje su: 

• 𝑘𝑠 – koeficijent sigurnosti 

• 𝐼2𝑛 – nazivna sekundarna struja homopolarne zaštite 
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Vrijeme odgađanja djelovanja homopolarne nadstrujne zaštite mora biti duže od vremena 

odgode svih ostalih zašita iste vrste i mora biti selektivno podešena s ostalim homopolarnim 

zaštitama.  [4] 

 

6.6. Distantna zaštita 

 

Distantnu zaštitu možemo izvesti na dva načina. Jedan je priključivanje distantnog releja s obje 

strane, a drugi samo s jedne strane štićenog transformatora. Uobičajeno ova zaštita služi kod 

visokonaponskih prijenosnih mreža, ali može biti i za potrebe zaštite transformatora ukoliko  

imamo jako dugo vrijeme djelovanja nadstrujnog releja. Na slici 6.7. je prikazan jedan od načina 

izvedbe.  

 

Slika 6.7. Prikaz postavljanja distantnog releja s obje strane transformatora 

 

Princip rada je da se uređaj distantne zaštite postavlja na dalekovod, tj. na njegov početak i 

kraj. Priključak se dovodi na transformatore u svrhu mjerenja, te na prekidač koji će vršiti 

aktiviranje zaštite. Izvedba distantnog releja je formirana sa tri faze i za svaku fazu ima prekidač 

odnosno isklop, te uklop. Ovakva izvedba je pogodna kod pojave jednopolnih kratkih spojeva jer 

se može isključiti određena faza u kojoj je nastupio kvar. [4] 
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Slika 6.8. Princip djelovanja distantne zaštite 
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7. PROGRAMSKI PAKET EPLAN 

 

Tvrtka EPLAN dio je Friedhelm Loh grupacije, a osnovana je 1984. godine. Oni razvijaju 

jedan od vodećih softverskih rješenja za projektiranje strojeva, ploča i upravljačkih ormara. 

EPLAN Electric P8 omogućuje softverska i servisna rješenja u području elektrotehnike, 

automatizacije i mehatronike. 

EPLAN Electric P8 omogućuje korisnicima izradu shema i dijagrama strujnog kruga. Softver 

podržava ručnu izradu sheme i izradu prema postojećim predlošcima, te generiranje i izradu 

dokumentacije i automatizaciju gotovog projekta. [5] 

 

7.1. Izrada sheme u EPLAN-u za proračun diferencijalne zaštite 

 

U daljnjem tekstu ćemo objasniti postupak izrade sheme. Nakon otvaranja programskog paketa 

EPLAN Electric P8 otvara se projekt s alatnom traku, te pritiskom na karticu Project → New 

kreiramo novi projekt. Nakon izvršenog koraka otvara se prozor u kojem definiramo ime projekta, 

mjesto na kojem ćemo spremiti projekt i predložak po kojem radimo. 

 

 

Slika 7.1. Prikaz kreiranja projekta 
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Nakon što se kreirao novi projekt iz alatne trake pozivamo karticu Page → New preko koje 

kreiramo stranicu, te se otvara prozor u kojem možemo definiramo karticu Full page name koju 

otvaramo pritiskom na ikonu označenu sa tri točkice, te se otvori prozor sa slike 7.3. u kojem 

definiramo polje (Higher-level function) u kojem se nalazimo i ormar (Mounting location) tj. 

lokacija. Dalje u kartici Page type stiskom na padajući meni biramo tip sheme koju crtamo za naš 

slučaj tropolna shema. U kartici Page description definiramo naziv stranice.  

 

 

Slika 7.2. Prikaz kreiranja nove stranice 
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Slika 7.3 Prikaz definiranja polja i lokacije stranice 

 

Kada smo iz definirali sve navedeno gore možemo krenuti sa crtanjem sheme. Ikona Interruption 

point služi nam za povezivanje vodiča ili sabirnica, a poziva se s desne strane u alatnoj traci. U 

slučaju da nam se ne nalazi u alatnoj traci pozivamo ju preko kartice Insert → Connection symbol 

→ Interruption point. Nakon što smo odabrali simbol iz prikaza slike 7.4. i postavili simbol u 

stranicu projekta otvara nam se prozor na slici 7.5. u kojem definiramo pomoću kartice Displayed 

DT oznaku simbola koju nam EPLAN automatski opredjeljuje, te u kartici Full DT vidimo ranije 

definirano polje i lokaciju u kojem nam se nalazi simbol.  

 

 

Slika 7.4. Prikaz odabira Interruption point-a 
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Slika 7.5. Prikaz definiranja parametara Interruption point-a 

 

U nastavku će se crtati simboli strujnog transformatora, stezaljki, diferencijalne zaštite, 

prekidača, osigurača,  lamp, sklopnika.  

Postupak pozivanja simbola strujnog transformatora je preko kartice Insert → Symbol, te se 

otvara prozor kao iz prikaza slike 7.6. U tom prozoru odabiremo mapu IEC_symbol → Electrical 

engineering → Convert, transformer, and rectifier i odaberemo strujni transformator kao iz prikaza 

slike. Nakon što smo simbol postavili u stranicu otvara nam se prozor sa slike 7.7 za definiranje 

transformatora. U kartici Converter definiramo opis stezaljki pomoću kartice Connection point 

designation i tehničke podatke elementa u kartici Technical characteristic.  
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Slika 7.6. Prikaza dodavanja simbola strujnog transformatora 

 

 

Slika 7.7. Definiranje strujnog transformatora 
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Postupak pozivanja simbola stezaljki je preko kartice Insert → Symbol, te se otvara prozor kao 

iz prikaza slike 7.8. U tom prozoru odabiremo mapu IEC_symbol → Electrical engineering → 

Terminal and plugs i odaberemo varijantu terminala kao iz prikaza slike. Definiranje stezaljki je 

kao i kod prethodnog simbola na slici 7.7. Na slici 7.9 je prikaz dijela elemenata kojih smo do sada 

nacrtali. 

 

 

Slika 7.8. Prikaz dodavanja simbola stezaljki  

 

 

Slika 7.9. Prikaz povezanih elemenata 
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Postupak pozivanja simbola prekidača je preko kartice Insert → Symbol, te se otvara prozor 

kao iz prikaza slike 7.10. U tom prozoru odabiremo mapu IEC_symbol → Electrical engineering 

→ Sensor, switch and pushbutton i odaberemo varijantu prekidača kao iz prikaza slike. Definiranje 

prekidača je kao i kod simbola na slici 7.7.  

 

 

Slika 7.10. Prikaz dodavanja simbola prekidača 

 

Na slici 7.11. prikazan je postupak odabira osigurača i diferencijalne zaštite. Simboli se 

pozivaju preko kartice Insert → Symbol. U otvorenom prozoru odabiremo mapu IEC_symbol → 

Electrical engineering → Protection device i odaberemo varijantu osigurača i diferencijalne zaštite 

kao iz prikaza slike. Definiranje osigurača i diferencijalne zaštite je kao i kod simbola na slici 7.7.  

 

 

 

 



54 

 

 

Slika 7.11. Prikaz dodavanja simbola osigurača i diferencijalne zaštite 

 

Na slici 7.12. prikazan je postupak odabira Change over contact (kontakti)  i sklopnika. 

Simboli se pozivaju preko kartice Insert → Symbol. U otvorenom prozoru odabiremo mapu 

IEC_symbol → Electrical engineering → Coils, contacts and protective circuits i odaberemo 

varijantu s 3 kontakta i sklopnik kao iz prikaza slike. Definiranje sklopnika i Change over-a je kao 

i kod simbola na slici 7.7.  
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Slika 7.12. Prikaz dodavanja simbola sklopnika i CHANGE OVER 

 

Na slici 7.13. prikazan je postupak odabira signalnog uređaja. Simbol se poziva preko kartice 

Insert → Symbol. U otvorenom prozoru odabiremo mapu IEC_symbol → Electrical engineering 

→ Signal device, optical and acoustic i odaberemo varijantu signalnog uređaja kao iz prikaza slike. 

Definiranje signalnog uređaja je kao i kod simbola na slici 7.7.  
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Slika 7.13. Prikaz dodavanja simbola signalnog uređaja 

 

Nakon što smo iz definirali sve potrebne elemente potrebno ih je spojiti. Programski paket 

EPLAN-a sam povezuje elemente koji se nalaze u istoj x i y ravnini. Za povezivanje elementa za 

koje to nije slučaj ili elementa koji se povezuje u 2 ili više grana to izvršavamo pomoću simbola 

koji se nalaze na desnoj strani alatne trake kao iz slike 7.4.. U slučaju da nam se ne nalazi u alatnoj 

traci pozivamo ju preko kartice Insert → Connection symbol, te odabiremo tip spajanja koji nam 

je potreban. 

Na slici 7.14. prikazana je gotova shema na kojoj će se vršiti proračun diferencijalne zaštite. 
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Slika 7.14. Prikaz sheme za proračun diferencijalne zaštite 
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8. PRIMJER PRORAČUNA DIFERENCIJALNE ZAŠTITE 

 

Za shemu sa slike 7.14. izvršiti će se proračun podešenja diferencijalne zaštite.  

Postupak započinjemo izračunavanjem impedancija na napon 𝑈𝐵1= 110kV. 

Impedanciju aktivne mreže izračunavamo pomoću izraza (8.1): 

 

      𝑍𝐴𝑀 =
𝑈𝐵1

2

𝑆𝐾3
" =  

1102

3000
= 4,03 𝛺   (8.1) 

 

Impedanciju transformatora izračunavamo pomoću izraza (8.2): 

 

𝑍𝑇 =
𝑈𝐵1

2

𝑆𝑛−𝑇
∗  

𝑢𝑘%

100
=  

1102

40
∗

12

100
= 36,3  𝛺 (8.2) 

 

Izračunavanje impedancija aktivne mreže, transformatora i voda na naponu 𝑈𝐵2= 20kV vrši se 

prema slijedećim izrazima: 

 

         𝑍𝐴𝑀 =
𝑈𝐵1

2

𝑆𝐾3
" =  

202

3000
= 0,13 𝛺     (8.3) 

 

  𝑍𝑇 =
𝑈𝐵1

2

𝑆𝑛−𝑇
∗  

𝑢𝑘%

100
=  

202

40
∗

12

100
= 1,2  𝛺     (8.4) 

 

  𝑍𝑉 = 𝑙 (𝑘𝑚) ∗ 𝑥1 = 2 ∗ 0,15 = 0,3 𝛺    (8.5) 

 

Izračunavanje struje kvara na mjestu kvara K1 vrši se prema izrazu (8.6): 

 

𝐼𝐾1−110𝑘𝑉 =
𝑐∗

𝑈𝑛

√3

𝑍𝐴𝑀+𝑍𝑇
=

1,1∗
110

√3

4,03+36,3
= 1,73 𝑘𝐴    (8.6) 
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Preračunavanje struje kvara K1 na napon 20 kV vrši se prema izraz (8.7): 

 

𝐼𝐾1−20𝑘𝑉 =  (
𝑈𝐵1

𝑈𝐵2
) ∗ 𝐼𝐾1−110𝑘𝑉 = (

110

20
) ∗ 1,73 = 9,52 𝑘𝐴 (8.7) 

 

Izračunavanje struje kvara na mjestu kvara K2 vrši se prema izrazu (8.8): 

 

        𝐼𝐾1−20𝑘𝑉 =
𝑐∗

𝑈𝑛

√3

𝑍𝐴𝑀+𝑍𝑇+𝑍𝑉
=

1,1∗
20

√3

0,13+1,2+0,3
= 7,79 𝑘𝐴  (8.8) 

 

Podešenje diferencijalne zaštite vrši se odabirom potrebnog strujnog transformatora. Zahtjev 

diferencijalnog releja za minimalni faktor dimenzioniranja je 𝐾𝑇𝐷 ≥ 4 za slučaj maksimalne struje 

kvara.  

Za izračunavanje potrebnog graničnog faktora točnosti koristimo slijedeći izraz (8.9): 

 

                   𝑛′ = 𝐾𝑇𝐷 ∗
𝐼𝐾−110𝑘𝑉

𝐼𝑛−𝑆𝑇
= 4 ∗

1730

300
= 23     (8.9) 

 

Podaci strujnog transformatora na 110kV strani transformatora za izračunavanje stvarnog 

graničnog faktora točnosti su slijedeći: 

• Klasa točnosti 5P 

• Prijenosni omjer 300/1 

• Nazivna snaga jezgre: 𝑃𝑛 = 8 VA 

• Vlastita potrošnja jezgre: 𝑃𝑣𝑙 = 2 VA 

• Potrošnja releja i vodova: 𝑃𝑟𝑣 = 2 VA 

 

Za izračunavanje stvarnog graničnog faktora točnosti koristimo slijedeći izraz (8.10): 

 

𝑛" ≥
𝑃𝑣𝑙+𝑃𝑟𝑣

𝑃𝑣𝑙+𝑃𝑛
∗ 𝑛′ =

2+2

2+8
∗ 23 = 9,2        (8.10) 
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Prema podacima koje smo dobili iz prethodnog izraza za transformator na strani 110kV 

odabiremo klasu točnosti i granični faktor točnosti 5P10.  

Podaci strujnog transformatora na 20kV strani transformatora za izračunavanje stvarnog 

graničnog faktora točnosti su slijedeći: 

• Klasa točnosti 5P 

• Prijenosni omjer 1200/1 

• Nazivna snaga jezgre: 𝑃𝑛 = 14 VA 

• Vlastita potrošnja jezgre: 𝑃𝑣𝑙 = 3 VA 

• Potrošnja releja i vodova: 𝑃𝑟𝑣 = 2 VA 

 

Za izračunavanje potrebnog graničnog faktora točnosti koristimo slijedeći izraz (8.11): 

 

                   𝑛′ = 𝐾𝑇𝐷 ∗
𝐼𝐾−20𝑘𝑉

𝐼𝑛−𝑆𝑇
= 4 ∗

9520

1200
= 31,7         (8.11) 

 

Za izračunavanje stvarnog graničnog faktora točnosti koristimo slijedeći izraz (8.12): 

 

                            𝑛" ≥
𝑃𝑣𝑙+𝑃𝑟𝑣

𝑃𝑣𝑙+𝑃𝑛
∗ 𝑛′ =

3+2

3+14
∗ 31,7 = 9,3          (8.12) 

 

Prema podacima koje smo dobili iz prethodnog izraza za transformator na strani 20kV 

odabiremo klasu točnosti i granični faktor točnosti 5P10.  

Izračunavanje potrebnih graničnih faktora točnosti na 110 kV i 20 kV stranama transformatora 

vršimo prema slijedećim izrazima (8.13) i (8.14): 

 

                               𝑛110−𝑘𝑉
′ =

𝑛

𝑛" ∗ 𝑛′ =
10

9,2
∗ 23 = 25              (8.13) 

 

                                𝑛20−𝑘𝑉
′ =

𝑛

𝑛"
∗ 𝑛′ =

10

9,3
∗ 31,7 = 34,1   (8.14) 
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Za provjeru odabranih strujnih transformatora uspoređujemo stvarne granične faktore koje smo 

izračunali i zadane struje strujnog i energetskog transformatora prema slijedećim izrazima (8.15) 

i (8.16): 

 

                  
𝑛110𝑘𝑉

′ ∗𝐼𝑛−𝑆𝑇− 110𝑘𝑉

𝐼𝑛−110𝑘𝑉
=

𝑛110𝑘𝑉
′ ∗𝐼𝑛−𝑆𝑇 110𝑘𝑉

𝑆

√3∗𝑈𝑛

=
25∗300

40000

√3∗110

= 35,72    (8.15) 

 

                   
𝑛20𝑘𝑉

′ ∗𝐼𝑛−𝑆𝑇− 20𝑘𝑉

𝐼𝑛−20𝑘𝑉
=

𝑛20𝑘𝑉
′ ∗𝐼𝑛−𝑆𝑇− 20𝑘𝑉

𝑆

√3∗𝑈𝑛

=
34,1∗1200

40000

√3∗20

= 35,43     (8.16) 

 

Usporedbom dobivenih podataka uočavamo da postoji uravnoteženje između obje strane 

energetskog transformatora. 
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9. ZAKLJUČAK 
 

Zaštita transformatora je ključna za održavanje sigurnosti i pouzdanosti elektroenergetskih 

sustava. Pravilo dizajnirani sustavi zaštite mogu spriječiti ozbiljnije kvarove, smanjiti rizik od 

nezgoda i produžiti životni vijek transformatora. Napredne tehnologije i sustavi daljinskog nadzora 

dodatno poboljšavaju efikasnost i pouzdanost zaštite transformatora.   

Kvarovi koji se pojavljuju mogu biti unutarnji i vanjski, te pojave smetnji. Najčešći kvar u 

transformatorima je degradacija izolacije zbog uvjeta preopterećenja sklopnih prenapona i munja. 

Osnovnu zaštitu transformatora čini diferencijalna zaštita koja djeluje na principu da zbroj svih 

struja, koje ulaze u zaštitne zone, mora biti jednak zbroju struja, koje izlaze iz zaštitne zone. U 

slučaju da to ne funkcionira dolazi do pojave grešaka. Efikasno djeluje na međufazne kratke 

spojeve, spojeve između zavoja i od proboja prema uzemljenim dijelovima.  

Zemljospojnu zaštitu svrstavamo pod diferencijalnu zaštitu. Ona štiti od proboja izolacija 

transformatora prema uzemljenim dijelovima, te za detekciju unutarnjih jednopolnih kratkih 

spojeva. Također uz diferencijalnu zaštitu koristi se nadstrujna zaštita i ona predstavlja pričuvnu 

zaštitu transformatora, a neophodna je za zaštitu namata. 

Programski paket EPLAN-a nam omogućuje projektiranje elektrotehničkih instalacija i 

sustava. Njegove funkcionalnosti olakšavaju proces projektiranja, smanjuje mogućnost grešaka i 

ubrzavaju proces izrade projekta. 
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SAŽETAK 
 

Transformatori su jedna od najkritičnijih i najskupljih komponenti svakog distribucijskog 

sustava. To je zatvoreni statički uređaj obično natopljen u ulje, pa su stoga kvarovi koji se javljaju 

na njemu ograničeni ali učinak nekog kvara može biti vrlo opasan za transformator a dugo vrijeme 

potrebno za popravak i zamjenu transformatora čini stvari još gorima. Stoga je zaštita energetskih 

transformatora postala vrlo važna. 

U okviru ovog diplomskog rada pojašnjeni su pojmovi transformatora i njegovih dijelova, 

nadomjesni modeli energetskih kvarova, vrste kvarova transformatora i zaštite transformatora. 

Vrste zaštita koje se koriste za zaštitu energetskih transformatora su diferencijalna zaštita, 

zemljospojna zaštita, zaštita od preopterećenja, nadstrujna zaštita, homopolarna zaštita itd.  

U ovom diplomskom radu također je opisan postupak izrade sheme u programskom paketu 

EPLAN koja se koristila za kasniji proračun diferencijalne zaštite energetskog transformatora. 

EPLAN Electric P8 je programsko rješenje za električni dizajn koje podržava 2D računalno 

potpomognuto inženjerstvo za izradu shema i dijagrama strujnog kruga. Softver podržava niz 

inženjerskih metoda uključujući ručnu izradu, pristupe temeljene na predlošcima i standardizirane 

pristupe.  

 

 

Ključne riječi: transformator, zaštita transformatora, EPLAN, diferencijalna zaštita 
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SUMMARY 
 

Transformers are one of the most critical and expensive components of any distribution system. 

Iti s a closed static device usually soaked in oil, so the failures that occur on it are limited, but the 

effect of a failure can be very dangerous for the transformer and the long time required to repair 

and replace the transformer makes things even worse. Therefore, the protection of power 

transformers has become very important. 

In this thesis, the concepts of transformer and its parts, alternative models of energy failures, 

types of transformer failures and transformer protection are explained. The types of protection 

used to protect power transformers are: differential protection, earth fault protection, overload 

protection, overcurrent protection, homopolar protection, etc. 

This thesis also describes the process of creating a scheme in the EPLAN software package, 

which was used for the subsequent calculation of the differential protection of the power 

transformer. EPLAN Electric P8 is an electrical design software solution that supports 2D 

computer-aided engineering for creating schematics and circuit diagrams. The software supports 

a variety of engineering methods including manual fabrication, template-based approaches, and 

standardized approaches. 

 

 

Keywords: transformer, transformer protection, EPLAN, differential protection 


